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ABSTRACT
INTRODUCTION: Image segmentation is a known problem in the fi eld of image processing. A great number of 
methods based on different approaches to this issue was created. One of these approaches utilizes the fi nd-
ings of the graph theory. 
METHODS: Our work focuses on segmentation using shortest paths in a graph. Specifi cally, we deal with meth-
ods of “Intelligent Scissors,” which use Dijkstra’s algorithm to fi nd the shortest paths. 
RESULTS: We created a new software in Microsoft Visual Studio 2013 integrated development environment 
Visual C++ in the language C++/CLI. We created a format application with a graphical users development en-
vironment for system Windows, with using the platform .Net (version 4.5). The program was used for handling 
and processing the original medical data. 
CONCLUSION: The major disadvantage of the method of “Intelligent Scissors” is the computational time length 
of Dijkstra’s algorithm. However, after the implementation of a more effi cient priority queue, this problem could 
be alleviated. The main advantage of this method we see in training that enables to adapt to a particular kind 
of edge, which we need to segment. The user involvement has a signifi cant infl uence on the process of seg-
mentation, which enormously aids to achieve high-quality results (Fig. 7, Ref. 13). Text in PDF www.elis.sk.
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Introduction

Image segmentation
Image segmentation is a classical problem of image processing, 

which is being studied during the last decade (1). Its main aim is 
to split the image into disjoint regions formed by pixels; each such 
region is bordering a meaningful object or area in the image. The 
regions created are usually referred to as segments. 

One of the biggest problems of image segmentation is am-
biguous image information, frequently accompanied by noise 
(2, 3). The more a priori information is available for the process 
of segmentation the better result can be achieved. Segmentation 
may be divided into:

1) Complete segmentation – dividing the image into non-overlap-
ping regions, corresponding to specifi c objects or areas of the image.

2) Partial segmentation – dividing the image into regions, 
which are homogeneous considering certain characteristics, such 
as brightness, color, and texture.

A high number of segmentation algorithms, which approach 
this problem in various ways, were developed. These methods can 
be classifi ed into fi ve groups (2, 3, 4, 5, 6).

1) Thresholding
2) The edge-oriented methods
3) Methods based on regions
4) Methods based on a comparison
5) Active contour models

Thresholding
It is the simplest segmentation technique, which is computa-

tionally undemanding and rapid. A constant value of brightness 
called threshold is used for segmentation of objects and back-
ground. These methods try to determine the threshold value auto-
matically. The threshold value may be constant for the entire image 
(global thresholding) or may vary in different parts of the image 
(local thresholding). Using global thresholding only in specifi c 
cases is suffi cient. In addition to these two basic types of thresh-
olding, there are many other specifi cations (3, 4).

The edge-oriented methods
They are based on edge detection using edge detector. These 

edges mark places where there is a change in the level of gray, 
color, and texture. The most common problem with this approach, 
due to noise or incorrect information in the image, is fi nding the 
edges in the inappropriate locations or absence of edges in the 
places where they should be located (3, 4).
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Methods based on regions
These methods do not seek border bounding regions, but the 

regions themselves formed by a set of pixels. These methods are 
appropriate in cases of noisy pictures when it is hard to fi nd the 
boundaries between objects. The basic idea of these methods is 
the division of the image into regions with the greatest possible 
homogeneity; the homogeneity criteria may be based on the level 
of gray, color, and texture (3, 4).

Methods based on a comparison
They are used to locate objects that are similar to the pattern 

designated by us. The correlation between the object and the pattern 
is determined by the optimality criterion based on the characteris-
tics of the object. The value of optimality criteria is calculated for 
each position and rotation of the pattern in the image. If this value 
exceeds a certain threshold, that location represents the location 
of the pattern (2, 3, 4).

Active contour models
We place an initial curve around the object that we wish to seg-

ment. The curve is then deformed in order to minimize the energy 
functional. This functional is formed as the sum of internal and 
external energy. The internal energy is designed by the shape of 
the curve. A smooth curve without signifi cant changes shall take 
the form of low value. External energy depends on the image and 
becomes a low value on the edges where the gradient shall make 
the greatest value (2, 3, 4).

A further possible division of the segmentation methods con-
stitutes of:

1) Automatic methods
2) Interactive methods
Automatic methods do not require the user interaction during 

the process of segmentation. 
The segmentation by these methods is, therefore, faster and 

more convenient. However, these methods do not always give the 
desired results, as in the case of medical data in which objects are 
ambiguously defi ned or contain strong noise. 

Interactive methods can overcome this problem by involving 
humans in the process of segmentation. The disadvantage is a long 
segmentation time and the need for participation of a person in the 
process of segmentation (1, 2, 3, 4, 5, 6).

Segmentation and graph theory (Fig. 1)
Many of the methods of image segmentation use the fi ndings of 

the graph theory. In this part of the paper, we describe these meth-
ods. However, we need to defi ne at fi rst certain concepts (1, 3, 4).

Let G = (V, E) be a graph, where V = {v1, v2, ..., vn} is a set 
of vertices that can represent a set of image pixels or regions in 
Euclidean space. Let E be the set of edges that connect adjacent 
peaks. Each edge (vi, vj)  E is measured by the weight w (vi, 
vj), which represents one variable dependent, for example, on the 
values of pixels that the edge connects. The image can be divided 
into separate components, being accepted that component A is a 
connected graph G = (V ‘, E’), where V’V, E’E and E’ contain 
only the edge of the vertices V’. Therefore non-empty sets A1, A2, 

..., Ak form a division of the graph G if Ai∩Aj =  for i ≠ j, i and 
j  (1, 2, … ,k) and A1… Ak = G. 

For the components should be valid, that the properties such 
as brightness value, color, and texture are similar throughout the 
whole component. Then, the degree of dissimilarity of two com-
ponents can be calculated as the cut of the graph. This cut passes 
through the edges in the graph, which divides the graph into two 
disjoint sets A and B. The graph cut is defi ned as

cut (A, B)=   ∑
uA, vB

w(u, v),

where u and v are the vertices of the different components, Fig. 
1. Afterwards, the issue of image segmentation can be treated as 
an optimization problem in which we try to minimize certain cri-
terion. In this case it shall be optimal to divide the graph into two 
segments, which minimize the graph cut.

Image segmentation is frequently formulated as a problem, in 
which we assign a value of L sets to elements from the set of sites 
S. An example could be set L = {object, background} and set S 
formed by the set of pixels of the image. In this way, the image is 
divided into two segments, and each pixel is clearly assigned to 
one of the two segments (1, 5, 7).

In the following text, we describe the basic partitioning meth-
ods using the knowledge from the graph theory (1, 6).

Methods based on minimal spanning tree
Frame T is a tree of a graph G, at which is valid T = (V, E ‘),

where E’E. The graph may have several different spanning trees. 
However, minimal spanning is the frame having the smallest scales 
on the edges from all the skeletons. The graph can have a number 
of different spanning trees; however, minimal spanning tree is the 
one having the smallest weight on the edges from all the spanning 
trees. To fi nd such a minimal spanning tree, we may use for in-
stance Prim’s algorithm, in which iteratively adding to the edges 
of the tree with the smallest weights. The main concept of these 
methods lies in the properties of the minimal spanning tree. It is the 
clustering of pixels with similar values into subgraphs. We obtain 
these subgraphs if the minimal spanning tree is partitioned in the 
places where the edges acquire the highest weight.

Fig. 1. (A) Illustration of two graph cuts. Cuts divide the image into 
three segments. (B) The assignment of values from the set L = {0, 1, 2} for 
the entire peak (pixels). The image again is divided into three segments.

A B
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Methods based on the minimal cuts
In addition to graph cut defi ned in the equation above, there 

are alternative defi nitions of cuts for which we want to minimize 
value. From the previous statement, the advantage of these methods 
is apparent, including the ability to use different types of cuts for 
various applications. The main disadvantage of the cut defi ned as 
(3.1) is a preference for fi nding small components. This problem 
can be solved by using a normalized cut

Ncut(A, B) = 
cut(A, B)

  +  
cut(A, B) ,

 
vol(A)

 
vol(B)

where the term volA = viA,vjV w(vi,vj) presents the sum of the 
weights among all the peaks of the A set and all vertices of the 
graph. If no edge appears between the vertices, then the weight 
shall equal zero. For in this waydefi ned cut it is valid that if the 
set A or B contains a few vertices, the value of the cut will not be 
low. Segmenting so defi ned cut also has its disadvantages, which 
are creating segments with similar weights on the edges. Another 
defi nition of a cut uses the information about the edge and interior 
of the segment. In particular, this cut is defi ned as

RegionCut (A, B) =    
cost(P)    ,

 
weight(P)

where P is an oriented path. In the graph G starting and ending at 
the same peak, Cost (P) is the length of the path P, and weight (P) 
is the sum of the weights of the area bounded by the path P. The 
main disadvantage of this cut defi nition is the preference of large 
objects and the need to segment only objects with closed borders. 
Besides these cuts, there are several other defi nitions (1, 3, 4, 7).

Graph cuts based on Markov random fi elds
Study of psychology has shown that to interpret an image it is 

necessary to take into account the context of the image information. 
It means that if we attempt to identify an object, which we do not 
see entirely, we may not succeed. The image should, therefore, be 
understood in the visual and spatial context. The theory of Markov 
random fi elds allows this approach (1, 2, 7, 8, 9).

Methods based on the shortest paths in graphs
Finding the shortest path between two vertices is a classical 

problem of the graph theory (for further reading about shortest paths 
in the graph, see (3, 4). The best-known algorithm that solves this 
issue is Dijkstra’s algorithm that, together with other, will be de-
scribed more closely later. Segmentation problem, in which we are 
looking for the best segment boundaries, is reformulated as a prob-
lem of fi nding the shortest path between two vertices. In practical 
applications, the user interaction is applied, thereby increasing the 
accuracy of the segmentation. The live-wire method is used, which 
allows the user to select the fi rst point on the border. Subsequently, 
the shortest route between the fi rst point and the actual location of 
the cursor is displayed in real-time. A user task is to select the posi-
tion of the cursor so that the drawn shortest path makes the best ap-
proximated the border part. Subsequently, new shortest paths will be 
drawn from this point, and this process iterates until the creation of 
closed boundaries. Formed boundary is represented by a sequence 

of oriented edges between pixels; each edge is valued. The value 
is low if the edge is appropriate as a border of the object. To create 
the shortest path between two points, it must pass through the edges 
with the lowest values. Hence the portrayed shortest path will cross 
the border of the object. This approach of segmentation requires the 
fi nding of the shortest paths from point to all other points in each 
step. It is also a major drawback whereas a certain computing time is 
needed, which increases with the number of pixels in the image. We 
describe a further segmentation technique called “Intelligent Scis-
sors,” based on the principle of seeking the shortest paths in a graph. 

In our work, we focus on graph algorithms seeking the short-
est path in the graph (10, 11, 12). Specifi cally, the application of 
Dijkstra’s algorithm method called “Intelligent Scissors.” At fi rst, 
we will describe Dijkstra’s algorithm and its method.

Dijkstra’s algorithm
Dijkstra’s algorithm solves the problem of fi nding the shortest 

paths in edge weighted and directed graph G = (V, E), whereas 
its all edge shall have non-negative weights (13). Thus the short-
est path is determined from a specifi c vertex to all other vertices. 
The algorithm maintains a set of vertices S, whose length of the 
shortest path has already been determined. The algorithm repeat-
edly chooses vertex uV-S with a minimum length of the shortest 
path adds the vertex u to the set S, and relaxes all edges directed 
from the vertex u. In the following implementation it is considered 
a priority queue Q of vertices, whose priority is determined by a 
minimum value d (.). This means that its vertices will be listed in 
increasing order according to the estimated value of the shortest 
path, whereas at the beginning of the queue is the vertex with the 
minimally assessed value of the shortest edge. 

Dijkstra’s algorithm pseudo-code looks like this:
Dijkstra [G(V, E), w, s]

1. INITIALIZE[G(V, E), s]
2. S=
3. Q=V
4. while Q≠
5. u=EXTRACT_MIN(Q)
6. S=S{u}
7. for each vertex v neighbors(u)
8. RELAX[u, v, w]

The initialization values d(.) and π(.) take place at the begin-
ning of the algorithm. Subsequently, S is adjusted to the empty set, 
and the priority queue contains vertices V. During the program run 
time; it is valid that Q=V-S. In the while loop, from the priority 
queue vertex u with the smallest value d is selected (.), which is 
then placed in the set S. As fi rstly selected vertex will be always 
initial vertex s chosen, from which we calculate the shortest paths 
to other vertices of the graph. In the lines 7 and 8, relaxation takes 
place for all edges directed from the vertex u. Therefore, if the 
path to the vertex v through the vertex u reduces the value d(v), 
we shall update the values d(v) and π(v). The algorithm never 
embeds new values to queue Q after line 3. Thus every vertex is 
selected from queue Q, and inserted into the set S only once. This 
indicates that the while loop will have exactly |V| iterations. The 
length of calculation time of the algorithm depends on how the 
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priority queue is implemented. If the queue is implemented as a 
fi eld, computational complexity of the algorithm will be O(|V|2). 
When using a Fibonacci heap as a priority queue, it is possible to 
achieve computational complexity O(|E|+|V|log|V|). 

Methods

Segmentation technique “Intelligent Scissors” (Fig. 2)
Now we describe an interactive segmentation technique called 

“Intelligent Scissors” (11). It is based on fi nding the optimal path 
in the graph, and its main advantage is the use of “live-wire”. 
This tool allows the user to interactively select the portion of the 
segmented boundaries so that the shortest path from the selected 
pixel to the current position of the mouse pointer will immediately 
be displayed to him.

Shortest paths are found for all pixels in the image, and thus the 
user can choose the shortest path that best describes the boundary 
of the segmented object. After selecting the shortest path, the pro-
gram uses the last pixel of that path to fi nd the shortest paths again, 
and this process continues until the creation of a closed segment. 
Therefore, the last selected pixel of the shortest path always forms 
a new starting pixel for the new part of the segmented boundaries. 
Boundary chosen in the previous steps remains constant.

The pixel is generated automatically using the technique of 
“boundary cooling,” to minimize the need to select a new pixel 
forming the end of the segmented portion. This technique uses 
the fact that most of the shortest paths will have several fi rst com-
mon pixels. Set of pixels, which is obtained as the intersection of 
a certain amount of shortest paths, is selected as the new part of 
the segmented boundaries. 

Selecting a new pixel includes another problem. This is the un-
certainty, which arises from the mouse handling and the small size 
of the pixel in the image. This issue is solved by so-called cursor 
snapping when a new pixel is chosen from a specifi c area, in which 
is the largest value of the size of the gradient situated. In addition, 
the technique of “Intelligent Scissors” includes an effective train-
ing. This allows the algorithm to adapt to different types of edges.

The image is represented by a graph, where each pixel of the 
image accounts for a vertex of the graph. All edges of the graph 
are valued and oriented by weight, with eight edges heading from 

each vertex to the neighboring vertex. The only exceptions are the 
vertices on the edges of the image. Figure 2 illustrates the vertices 
and edges of such graph. Preview of the tool “Live-wire” in image 
segmentation is shown in Figure 2.

The calculation of the weight values on the edges
If p and q are two adjacent pixels in the image, then l(p, q) 

is the weight value of the directed edge from the pixel p to q [8]. 
The function l(p, q) is a weighted sum of the functions of image 
characteristics, which are:
fZ: Laplacian zero-crossing
fG: Gradient size (magnitude)
fD: Gradient direction
fP: Pixel value 
fI: “Inside” value of the pixel
fO: “Outside” value of the pixel
Thus the resulting function l(p, q) has the following form:
l(p, q) = ωZ * fZ(q) + ωG * fG(q) + ωD * fD(p, q) + ωP * fP(q) + ωI 
* fI(q) + ω0 * f0(q),

where ω is the weight of each respective function. All these 
features have the range of the interval 0, 1. Empirically, it was 
determined that weights ωZ = 0.3, ωG = 0.3, ωD = 0.1, ωP = 0.1, ωI 

= 0.1 and ωO = 0.1are giving good results for most images. If nec-
essary, these weights can be modifi ed, but the sum shall be equal 
to 1.The functions fZ, fG and fD are termed static features. It means 
that they are fi xed and do not use any a priori information about 
the image. Thus, their functional coast is fi xed. On the contrary, 
the functions fG, fP, fI, and fO are designated as dynamic. 

Results and discussion

Implementation, new approach, and optimization (Fig. 3)
Our aim was to implement the method of “Intelligent Scis-

sors.” We created new software in Microsoft Visual Studio 2013 
integrated development environment Visual C++ in the language 
C++/CLI. We created a format application with graphical users de-
velopment environment (Windows Forms Applications) for system 
Windows, with using the platform .Net (version 4.5).

The graph is often used in the memory of the computer as the 
matrices of adjacencies (2, 3, 4). For representation of the image 
of the graph we created classes for a graph. It contains informa-
tion about the height and weight of the picture and one dimension 
- fi eld, which size is equal to the number of pixels. Every vertex 

Fig. 2. Illustration of pixels and oriented edges in a graph represent-
ing an image.

Fig. 3. Every vertex keeps the information about the color of the pic-
ture and eight-elements fi eld of edges into adjacent vertices.
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keeps the information about the color of the picture and eight-
elements fi eld of edges into adjacent vertices. Indeces of edges in 
this fi eld are shown in Figure 3.

The object of the class has like data for identifi cation of the 
number of the entering vertex and also the weight on this edge. 
For the counting the responsible values of the functions fZ and fG 

the user has to choose three values for the standard deviation σ, 
which determines the size of preimage of the image. The values 

of the functions fD and fZ are counted just in the beginning of the 
segmentation after loading the image. The values of other func-
tions are necessary to count always again.

The class Intelligent Scissors contains data and methods, which 
specify its running. As an example, we can mention the value set 
the weights wZ, wG, wD, wP, wI and wO, or a fi eld of the pixel, which 
form the boundary of the segmentation. By active training, we 
use by creating histogram decreasing function of the weight w(i), 
which returns higher weights for pixels, which are at the begin-
ning of training set. This function is defi ned as:

w(i) = − (           i        ) + 1,
 

2 . (tS + 1)

where ts is the number of pixels in entering set and i = 0, 1, … , ts 

-1. It is a linear function, for which it holds w(0) = 0 a w(ts -1) = 
0,5. We created for searching the shortest path created individu-
ally class. At the end of segmentation, it is necessary to close the 
boundary of segmentation by choosing small sizes of pixels. The 
user has a possibility to choose the size of the surrounding area, 
which is defi ned for touching the cursor. It means, if the initial pixel 
is located in the surroundings of the last chosen pixel in the image, 
the segmented edge will be automatically closed. After creating 
closed segment the user can to remove the rest of the segmented 
region. For this reason, it was necessary to line seeds to fi ll in the 
region (“scan – line seed fi ll”). In this way we were able to detect 
the set of all pixels of the image located in the segmented part.

User interface (Figs 4, 5, 6, 7)
The user interface is very intuitively and easy to follow. The 

fi rst set is uploading the image. Supported formats are JPG, PNG, 
and BMP. The image is uploaded by clicking the mouse on offer 
File→Open. Consequently, we can choose and select from the 
standard window for opening fi les. After uploading the fi le, the 
window with settings will appear (Fig. 4).

All decimal numbers are necessary to submit with a comma. 
The fi rst quaternion represents standard deviations of the num-
ber convolution masks. The user can settle the value of standard 

Fig. 4. The window in the program with settings.

Fig. 5. CT image of the head without pathological changes. A) The 
original image B) The image after applying our segmentation, which 
is based on Intelligent Scissors, on the lateral ventricle.

A B

Fig. 6. MRI scan of lumbosacral spine with paramedian disc (L4/L5) herniation on the left side. A) The original image, B) The image after applying 
our segmentation, which is based on Intelligent Scissors, on the dural sac. C) Unsuccessful application of thresholding method on the dural sac.

A B C
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deviations for counting values of the function of the size of the 
gradient fG. The next quaternion represents the same, just for the 
function fZ. On the right-hand size is the setting of the correspond-
ing weights for the convolution center. Hex of weight represents 
the size of the gradient of the responsible functions of the weights 
of the edges in the graph. As the last one possibility for setting, 
there is the setting of the maximal integrated value of the weight 
in the edge. All these setting are available just by uploading the 
image. After the confi rmation by the button Apply the uploaded 
image is pictured in the main menu. Other types of settings are 
available through the menu File→Properties. They are available 
the whole time during the segmentation.

The fi rst step of the segmentation is to choose the initial point. 
The user starts creating boundaries from this point. The user by 
moving the mouse and clicking on the mouse selects a new region, 
which will create a new part of the segmented boundary. After ev-
ery click of the mouse, the user chooses a new point of the border, 
from which the shortest path in the graph is created. After closing 
the segmentation boundary, the image is divided into two regions. 
The user selects a region, which he considers as a fi nal segment 
by clicking in the corresponding region. The user has a possibil-
ity to save the coordinates of pixels creating the boundary of the 
segmentation (File→Save→Coordinates), or the selected part of 
the image in format PNG by the menu File→Save→Segment. 

The user can any time during the segmentation check the 
values of the weights on the edges by the menu Show→Graph 
weights. The user can close the application anytime by choosing 
the offer File→Close. Basic information about the program is in 
Help→About.

The program was used for handling and processing the original 
medical data. The images come from different parts of our medical 

faculty. In this section of the paper, we are applying our imple-
mented segmentation, which is based on “Intelligent Scissors,” on 
the biomedical data. Figures 5 – 7 illustrate the segmented results.

Conclusion

The method of “Intelligent Scissors” is like any other method, 
has its advantages and disadvantages. The major disadvantage is 
the computational time length of Dijkstra’s algorithm. However, af-
ter the implementation of a more effi cient priority queue, this prob-
lem could be alleviated. Another disadvantage is the need to know 
how the method works, or at least to know what the effect of alter-
ing specifi c parameters is. The main advantage of this approach, 
we see in training that enables the method to adapt to a particular 
kind of edge, which we need to segment. Another advantage is the 
number of settings that allow the user to adjust the method to a wide 
variety of different images. The user involvement has a signifi cant 
infl uence on the process of segmentation, which enormously aids 
to achieve high-quality results. The greatest challenge and a great 
potential for the future, we see in the processing of biomedical im-
ages, where we need to seek and to distinguish local and global seg-
mentation. This is of great use in the processing of biomedical data.
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A B

Fig. 7. CT image of the head with subarachnoid hemorrhage. A) The 
original image, B) The image after applying our segmentation, which 
is based on Intelligent Scissors, on the subarachnoidal hemorrhage.


